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Introduction  

 
European Induction Support System (EIS-ALP) project is set on finding out what is that a prison 

educator has to do that is different or over and above what teachers in other areas of the lifelong 

learning sector has to do. Within the project a European Induction Support System (EISS) was 

developed, a web-based tool for adult learning professionals to assess and further develop your key 

competencies in prison education.  

 

EISS offers users a coherent and competency-based learning and development pathway in 5 

languages (English, Maltese, Portuguese, Romanian and Slovenian):  

1) a self-assessing tool that places existing competencies in context and gives users a possible 

development solution  

2) a number of modular blended-learning experiences to work upon the assessed 

competencies 

3) a virtual European library.  

 

Thus it stimulates professional development as well as the experience, contributes to personal 

cultural integration and understanding with promoting dialogue as a main tool for adaptation. 

 

The EISS platform is designed for existing and future prison teachers. Navigation and the materials 

are offered in 5 European languages: English, Maltese, Portuguese, Romanian and Slovenian which 

can be chosen upon users’ sign-in. Chamilo backbone offers the possibility to regularly add the 

teaching modules and thus keeps user-experience always fresh and fulfilling.  

 

This EISS User Manual focuses on the user-friendly experience with EISS, helping teachers to be 

acquainted with the platform and use it easily. It is accessible in 5 languages (English, Maltese, 

Portuguese, Romanian and Slovenian). It contains instructions for users on how to use the platform. 

Application supports the following users:  

• administrators,  

• teachers and  

• participants.  

 

Administrator takes care of the administration of the platform only and is not included in the 

mentoring system. The platform enables teachers and participants (learners) to plan and monitor 

the vocational path of each individual and provide the overview of testing of the platform in partner 

states. Platform runs on the web, so a web browser is needed for working with the application. For 

individual off-line training materials are downloadable. For internet free use of the platform, a 

downloadable package is available on http://www.eisalp.eu/. 

EISS is based on Chamilo platform. Chamilo LMS is a learning management system designed to 

support effective online education (often referred to as e-learning). Chamilo has a detailed Chamilo 

Teacher`s Guide1 for more information on the use of Chamilo software because the intention of EISS 

User Manual is to complement the Chamilo Teacher’s Guide and not to supplement it. Chamilo is 

“free” software which has been developed through the collaboration of various companies, 

                                            
1 Teachers guide (Chamilo 1.9): http://cdn-chamilo.cblue.be/docs/en/chamilo-teacher-guide-1.9-en.pdf 
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organizations and individuals according to a model known as open-source, but with stricter ethical 

values. Platform uses the open source system Chamilo thus it requires server with Apache (1.3, 2.0 

or 2.2), MySQL data server (5.1) and PHP (5.3 or more). Platform should work on the majority of VPS 

or shared hosting servers. 

 

The focus of the EISS User Manual is to help users of the platform to be acquainted with the 

application and easily use it. The manual was tested and improved during the pilot phase of the 

project to achieve the level of clear yet user-friendly language, structure and visual impact:  

 

First chapter describes the possible users of the platform according to their rights (administrator, 

teacher, and participant). It further explains how to technically access EISS, how to register and login 

every time one decides to use it. 

 

The second chapter goes deeper into the use of EISS. It leads the user through my courses, personal 

plan, reporting, social networks and self-assessment.  

 

The third chapter is dedicated to participants referring to chapters, important for their use of the 

platform. 

 

The fourth chapter presents the use of the virtual European library with documents from other 

European projects with similar content and other useful materials. 

 

 

For advanced users it is recommended to use EISS User Guide in combination with the Chamilo 

Teacher`s Guide which offers detailed information and instructions.  
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1. PLATFORM: REGISTRATION  
 

EISS enables teachers and participants to plan and monitor the vocational path of each individual 

and provide the overview of testing of the platform in partner states. 

EISS offers three levels of users, which differ by their administrative rights:  

• For the administrator a certain level of technical knowledge is demanded to install EISS, 

assign teachers rights to teachers and assist users when using the platform. Administrator 

has an overall in look into all the data inside the platform. 

• Teachers are in the role of a teacher and thus have more rights as participants - they can 

create courses, do the assessment and action plan for their participants. 

• Participants are in a role of a learner and thus get the access to a limited number of features 

- teachers give them assignments to follow and co-create. 

 

The platform package is available for downloading on http://www.eisalp.eu/ free of charge. 

Instructions for downloading are included in the package.  

 

1.1 Registration  
 

When you register, you automatically get limited rights (become “participants”) thus:  

IMPORTANT! If you are a teacher, inform your administrator to give you teachers rights after you 

register to the platform. 

 

A new user can register in 4 simple steps: 

1) Access the platform. EISS is available in 5 languages: English, Maltese, Portuguese, Romanian 

and Slovenian. You can choose between the above-mentioned languages in the pull-down 

menu. The “Welcome” text on the right will appear in the language you will choose and so 

will all the menus in the platform. For registration click the “Register” choice: 
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2) Insert the data in the form below (data in fields, marked with a star *, are mandatory): 

 

3) After entering all the data and submitting it by clicking “Register”, successful registration 

form welcomes you – click the button “Next” for entering the platform. 

4) Save your username and password data for further use after receiving it on your email. In 

case you are a teacher, inform your administrator to administer you teacher`s rights. 

             

The language, appearing here is the same as you 

have chosen before entering the EISS.  

 

You can change the language in the »Edit profile« 

(Chapter 2) 

Choose your language 

Register 
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1.2. Login - Logout 
Registration is a one-time procedure; afterwards you can access EISS through 4 steps Login – Logout 

process:   

1) Visit the platform 

2) Choose your language in the pull-down menu  

3) Insert your login data (username and password)  

4) Enter EISS by pressing the “Login” button  

 
 

 
 
 

 

After you have finished using EISS, it is recommended to logout by clicking the red button next to 

your user name  .  

 

This way you will prevent others to use EISS under your name which might happen by only closing 

the window or browser especially if you are working on a public computer.  

 

 

 

 

 

 

 

 

 

2) Choose your language 

3) Insert your »Username« and »Password« 

4) Login 
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2. PLATFORM: USE FOR TEACHER 
 

After entering EISS the welcome-screen presents basic features of the platform. Homepage opens 

and always stays in the yellow menu bar as the first option.  You can: 

 

 
 

 

 

 

 

The green row above the text encompass basic tabs of the MS4ROW platform:  

• MY COURSES,  

• PERSONAL AGENDA,  

• REPORTING,  

• SOCIAL NETWORK,  

• SELF-ASSESMENT. 

 

 

Tabs “Personal Agenda, Social Network, Reporting” support the monitoring of the participant’s 

progress on their educational path and career growth.  

 

Tabs “My courses, Social Network, Reporting, Self-Assessment” support online learning of the 

platform users. 

 

 

 

Check your messages in your »Inbox«. 

 

»Compose« messages. 

 

Check »Pending invitations« - invitations waiting for your 

response. 

 

»Edit profile« by changing the language, add picture etc. You 

have to save the inserted data by clicking the »Save settings« 

button.  

Another possibility to edit your profile is by clicking the arrow 

next to your name and choose »Profile«. There you can also 

check your »Inbox« messages.  
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2.1. My courses 
 

Under “My courses” two possibilities are offered: 

• To use EIS ALP courses, developed within the project as explained in the following chapters 

• To import existing e-learning materials as SCORM packages, created outside EIS ALP project. 

For instance, if your organisation uses a Moodle course focusing on increasing 

communication competences you are free to bring it into the EISS as the Chamilo upon which 

our web-tool is based on enables s.c. SCORM compatibility therefore enabling the usage of 

any document you have previously imported or created 

(e.g.   a   SCORM   course,  .html  pages,   videos,   images,   etc.). For more information refer 

to Chamilo Teacher`s Guide. 

 

 

By selecting “My courses” the following window appears: 

 

 
 

“My courses” are meant for:  

• describing the course: number of hours, main aim of the course, duration, educational goals, 

gained competencies, 

• creating tasks/duties for the learners within the specific course, 

• putting activities/course/workshop on the calendar, 

• uploading materials, links, videos etc. for the learners (all enrolled learners – users – will be 

able to see it if a teacher will make things visible to users), 

• uploading photos from the event etc. 
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2.1.1. Teacher / Learner View 

 

“My courses” contain modules, developed within EIS ALP project, contain the following content, 

seen by the participant (learner): 
 

 
 

Teachers are stimulated to present the materials to participants in the following order: 

1. »Course description« to get an overall picture of the module 

2. »Documents« with the Power Point Presentation and in some cases additional documents 

under subfolder »Library« which serve as core module learning content 

3. »Learning path« with inserted excercises for practicing gained knowledge 

4. »Tests« with inserted assignments to test the gained knowledge 

 

 

For participants only »Learners View« is available while teachers can either select »Teachers« or 

»Learners view« as they have more administrative rights: 

Session Plan 

Assignments 

• Power Point Presentation 

• Additional learning  documents  

Excercises 
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Under »Teacher View«  two sets of icons appear: 

• Authoring 

• Interaction 

 

2.1.2. Authoring 

Beside above presented icons »Course description, Documents, Learning path, Tests« which already 

contain materials, the following icons are reccomended to be used by teachers to enrich 

cooperation with participants: 

 

TEACHER / LEARNER VIEW: 

By selecting »Teacher View« all the content for teachers appear 

(the button appears as »Learner View«, giving you the 

opportunity to switch it into »Learner View«). 

 

With a click you can change it into »Learner View« which present 

the view of a participant (the button than appears as »Teacher 

View«, giving you the opportunity to switch it back into »Teacher 

View«). 

 

Teachers can administer the content for learners by clicking 

the eye icon.  

 

When an eye icon is displayed with an open eye (and the 

icon appears in colours), the participant  will see the icon. 

 

When the eye is closed (and the icon appears in grey 

tones), the participant will not see this icon.  

 

»Administration« icons offer:  

- »Reporting« on teachers and participant activities 

- »Settings« for setting categories, language, rights etc. 

- »Backup« to make a safe copy or export the course.  
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»Attendances«  

Under »Attendances« you can either follow the statistics of the attending 

participants:  

 

 
 

Or create a new attendance list by clicking the icon  where the following window appears:  

»Attendances« can be 

used for the 

registration of 

attendance by 

participants. 

»Announcements«, 

related to the course, 

will be flagged up to 

participants when 

they log in to the 

course. They can be 

personalized and 

configured to be sent 

via email to chosen 

participants. It is also 

possible to   attach 

documents to 

announcements. 

 

"Links" can be used to add links 

to external websites from within 

the course especially if you have 

country-specific sources. 

 

"Glossary" is meant to add and 

view terms and definitions 

(including sound, graphics etc.) 

and to import and export 

text .csv lists or save the 

glossary as a .pdf file. It could be 

useful for country-specific 

expressions. 
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»Announcements«  

Under »Announcements« you can add an announcement by clicking the following 

button:  

 
 
 

 
A window with furter data of your announcement appears: 

 

Insert the »Title« 

 

 

Insert the »Text« 

 

By choosing »Advanced settings« you can 

include the attendance list into the assesment 

tool by clicking the box 

 

»Save« will save your choices 
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»Links«  

Under »Links« the following window appears: 

 

 

 
 

Under »visible to« choose to whome you will 

send the announcement: 

• To all users 

• To specific users 

• To users in all sessions of this course 

• By email to selected groups/users 

 

Insert »Subject« 

 

 

 

 

 

 

 

 

Insert »Text« 

 

 

 

 

 

Add »Attachment« 

 

By clicking »Send announcement« your 

message will be sent out 
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Choosing the  icon you can insert web-links by URL, text of the link, metadata, description, 

you can show link on training homepage and link target: 

 

 
 
 
 

Choosing the  icon you can arrange your links into categories by category name, adding a 

short description: 
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»Glossary«  

Choosing »Glossary« you can either: 

 

 

 

• Insert new terms (term and definition) under  icon 

• Export the glossary as a CSV file under  icon 

• Import new glossary as a CSV file under  icon 

• Export glossary as a PDF file under  icon 

• Choose between »Table View« and »List View« under  icon 

 

 

 

2.1.3. Interaction 

Under “Interaction” section the following icons are proposed to be used by teachers and 

participants to enrich cooperation: 

 
 

"Agenda" offers 

a comprehensive diary

/calendar for adding 

events etc. 

 

"Users" allows participants to view who else is subscribed 

to the course, and teachers to manage course users, 

subscribing teachers and users, and importing and 

exporting course lists as required. The users tool also 

integrates with the Groups tool. 

"Surveys" enable 

inviting users on the 

platform to quickly 

and easily offer 

comment and 

feedback for the 

evaluation and 

development of 

courses. The 

tool also supports 

the analysis of results  

collected from 

participants. 

"Notebook" keeps private notes 

regarding the course of a teacher 

or participant private. It provides 

a simple means for users to write 

and store and organize such 

notes within the platform for 

their own use, using the on-line 

editor. Notes created by this tool 

are private: no user has access to 

the notes of another user. 
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»Agenda« 

By clicking the »Agenda« tab the following screen opens: 

 

 

 

 
 

Choosing the »Add event« option you can insert more details about the event (as shown below) by: 

• »Event name« 

• »Users« to select them under »To« 

• »Start date« of the event 

• »All day« if the event will last the entire day 

• »Repeat event« if it will happen »Daily, Weekly, Monthly, by date or Yearly« with choosing 

the »Repeat end date« 

• »Description« of the event 

• »Add attachment« to the event 

• »Comment«  

Create event in your calendar by:  

• clicking the date in the calendar where the data can be inserted by defining users 

under »To« and adding »Title« and »Description« of the event. You can also »Add 

as an announcement« by clicking the box. You finalise the event by pressing »Add«. 

• »Add event« where the data is can be inserted as described below. 
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• »Add as announcement« for your teachers or participants 

 

 

 
 

 

 »Users«  

By clicking the »Users« icon the list of users appear: 
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This example shows one teacher who is active in the course. You can add other teachers and 

participants by clicking »Enroll users to course«  icon. The list of users appear and you can 

choose the users you want to register for your course choosing the icon : 

 

 
 

Registered users appear on your list and you can check it returning to »Users«: 

 

 

Users can be unregistered by clicking the button .  
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This way you can also enroll teachers using the icon .  Other icons offer to export  and 

import  data as CVS file, to export data as Excell  or PDF  file, manage groups  

and add classes . 

 

 

 

»Surveys«  

Under »Surveys« a »Survey list« appears with two icons where you can either create 

new surveys by clicking  or search for surveys by »Title«, »Code« and »Language« 

by clicking .  

 

 

To create surveys you can insert very specific data (as shown in the print-screen below): 

• »Code« under which the survey will be kept 

• »Survey title« 

• »Survey subtitle« 

• »Start date« of the survey 

• »End date« of the survey 

• »Survey introduction« 

• »Final thanks« 
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Under »Advanced settings« the further detailes can be choosed: 

• »Grade in the assesment tool« 

• Choosing »Parent survey« 

• Determining »One question per page« 

• »Enable shuffle mode«  

 

After inserting all the details press the button and the following screen appears: 
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The first grey row allows you to edit the survey , delete it , preview the survey , 

publish it  or see a survey report .  

 

Icons in the second grey row enable different types of questions in your survey (starting from the 

left to the right):  Yes/No, Multiple choice, Multiple answers, Open, Dropdown menus, Percentage, 

Performance, Comment and Page end (separate questions). 

 

 

 

»Notebook«  

»Notebook« offers space to create notes by »Note title« and »Note details« under 

the  icon, and to sort the notes by date of creation , by date of last 

modification  and by title  as shown on the print-screen below. 

 

 

 
 

 

 

2.2. Personal agenda 
 

"Personal agenda" offers a personal diary/calendar for adding events and making personal plans. 

 

By clicking the »Personal agenda« tab the following screen opens: 
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Create an event in your calendar by either clicking the date in the calendar or by clicking the  icon. A 

window will appear as shown above where the data can be inserted by »Title« and »Description« of the 

event. You finalise the event by pressing »Add«.  

 

You can list the events with the icon . 

 

 

IMPORTANT! There is a distinction to the »Agenda« inside »My courses« - the note under »Personal 

agenda« goes into »Personal calendar« as marked in blue while the notes under »My courses« are 

connected to courses.  

 

 

 

 

 



                                                                                                                                
                    
 

This project has been funded with support from the European Commission. This publication reflects the views only of the author, 

and the Commission cannot be held responsible for any use which may be made of the information contained therein. 
    23 

2.3. Reporting  
 

The “Reporting” tab allows teachers an overview of what is happening inside all assigned activities. 

The main page of the “Reporting” tab displays summary tables offering a general overview, some 

statistics relating to participants on their activities, and a list of activities for which you teachers are 

responsible: 

 
Under “Overview” the following statistics appear, signifying: 

• “Followed students” is a list of courses participants. You can have an in look into all the 

details of each participant (his/her courses, how much time he/she spent on them etc.) by 

clicking   

• By clicking on “Followed teachers” a list of teachers appears listed in an online EISS 

classroom. You can see how many classes teachers created, including its statistics. 

• “Followed users” are all users with active accounts (teachers and participants). More details 

on each user can be find in “Details.” 

• “Followed courses” show detailed data per course (the number of participants, average 

course time etc.).  

 

 

The second part of the “Reporting” is statistical: the number of courses per participant, time spent 

in the application, number of participants not logged-in for more than a week etc.  
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2.4. Social network  
 

Teachers are recommended to have an effective online social interaction with their participants, as 

it is an important element in successful online learning and participant’s vocational and educational 

path. The “Social network” facility is designed to optimize support for teachers and participants 

wanting to make use of various social network features as an integral part of their online learning 

(and teaching) experience. These include simple profiling, an internal messaging system available to 

users and the facility to create interest groups.  

 

After clicking on “Social network”, the following appears: 

 

 
 

The menu on the left offers the following possibilities, further presented below: 

• “Messages”  

• “Invitations” 

• “My shared profile” 

• “Friends” 

• “Social groups” 

• “Search” 

• “My files” 

 

 

2.4.1. “Messages” 

By clicking the »Messages« you can choose between two icons:  

•  to compose a new message or  

•  to list all received and sent messages. 

 

 

By »Edit profile« you can change your user data, language, 

picture, the password for accessing the EISS etc. 
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For composing a message ( icon) a template opens as shown below, where you can insert the 

participant under “Send to”, “Subject”, “Message” text and one or more “Files attachments” with 

20 MB maximum file size with a “Description”. 

 

Under the list of all sent and received messages (  icon) a list opens as shown below, where 

you can see your listed messages by Subject, Sender/Recipient, Date, read your messages by 

clicking message yellow titles and you can also edit them:  

 

 

»Select all« marks all messages. 

They can be unselected by 

»Unselect all«. »Detail« offer to 

delete all selected messages at 

once while you can delete them 

one by one by clicking the red x 

under »Edit«. 
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2.4.2. “Invitations” 

“Invitations” offers the search of participants-friends for messaging and chatting: 

 
 

 

 

2.4.3. “My shared profile”  

When selecting “My shared profile” tab you get an overview of your EISS activities through the 

following options “Profile data”, “My friends” and “Activities”: 

 

You can send the user 

(participant)  Invitation or 

Message. 

 

User (participant) becomes 

your »Friend« after he 

confirms your »Invitation«.  

Click on »Try and find some friends«, write a name, click 

»Find« and searched user will appear if he`s in the 

application`s database. 

 

You can send the user (participant)  »Invitation« or 

»Message«. User (participant) becomes your »Friend« after 

he confirms your »Invitation«.  
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2.4.4. “Friends” and “Search” 

Add your participants as friends, chat with them etc. and boost your trustful relationship with them. 

When you will start using the application, no “Friends” will appear on your list. They will appear on 

your “Friends” list after you confirm their invitation or they confirm your invitation for friendship. 

You can add friends to your list under “Friends” by clicking “Try and find some friends” button: 

  
 

 

The same can be done through the “Search” button. When a friend, listed in the platform, appears 

as the result of your search, you can send him either an invitation by “Send invitation” or a message 

by “Send message”: 
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When you will make friendships, the list shows your friends: 

 
 

 

If you prefer not having a certain »Friend« on your list, you can use the option »Delete«. If you 

would like to know your friend`s specifics, click on your friends name (yellow written, below the 

picture): 

 
 

Short instructions for chatting: 

1. Activate Chat (green circle in the lower right corner of the EISS)  

2. Click your friend 

3. Click »Chat« 

4. A window opens for chatting and you can easily chat with your friend. 

 

 

2.4.5. »Social groups«  

On the upper grey menu groups »Newest«, »Popular« and »My group« are preented as a compile 

of all groups that exist on the platform. These groups can only be created by administrators, 

unless they have enabled this option for all users. 
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2.4.6. “My files”  

“My files” works like a storage box in which you can add files, photos, links and other private files: 

 
 

 

 

2.5. Self-assesment 

“Self assessment” tab enables participant to self-evaluate competencies where additional 

knowledge is needed.  Evaluation is prepared as a questionnaire with competences on the left side 

of the chart and with 1 – 5 scale where “1” means “Low proficient” and “5” means “High proficient”: 
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The test can easily be solved by clicking the circle by one of the numbers from 1 – Low proficient to 

5 – High proficient. 

 

IMPORTANT! You have to answer to all the questions for submitting the evaluation (else the form 

will not let you go to results). 
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Results show the average percentage per competence. Where the percentage is below 70, curses 

are suggested: 
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Teacher can administer the courses by the proposed competencies by clicking on the pull-down 

down menu and choosing the appropriate course for the competence: 
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3. PLATFORM: USE FOR PARTICIPANT 
 

EISS welcomes participants with the following view:  

 

 
 
 

Six tabs are available for participants with limited administrative rights (participants can 

participate in courses and events but cannot administer them): 

• HOMEPAGE – more under chapter “2. Platform: use for teacher” 

• MY COURSES – more under chapter “2.1. my courses” 

• PERSONAL AGENDA – more under chapter “2.2. Personal agenda” 

• PROGRESS (“Reporting” for teachers) - more under Chapter “2.3. Reporting” 

• SOCIAL NETWORK – more under Chapter “2.4. Social network” 

• SELF-ASSESMENT – more under Chapter “2.5. Self-assessment” 
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4. LIBRARY 
Virtual European library encompass documents from other European projects with similar content 

and other useful literature. It is structured by level of knowledge with basic texts for newcomers 

and advanced texts for improving basic knowledge. Further it is segmented by competences and 

each competence has documents separated by project languages:  
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Library is inserted into the EISS platform as a course and can be accessed through “My courses” tab:  

 
 

To view the existing files or upload new files into the library click the module and: 

1. Click “Documents”  icon to open the file system: 

   
2. By clicking the folder name choose either “Advanced texts” either “Basic texts” 

3. Further by clicking the folder name choose one of the listed competences 

4. Further by clicking the folder name choose one of the listed languages 

5. View the files by clicking on the file or choose one of the following options from the grey 

menu: go back , create new document , draw a picture/chart/etc. , upload 

an existing file and/or send it to a recipient , create new folder , check available 

space , search files or change the folder by the pull-

down menu: 

 
 

Find all additional information and instructions use 

Chamilo Teacher’s guide 


